Getting started
With

Solid Edge



Welcome!

This Test Drive demonstrates typical workflows for modeling parts, creating assemblies, creating
detailed drawings, and performing finite-element analysis simulations with Solid Edge. Get
behind the wheel and discover for yourself how easy Solid Edge is to use!
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This Test Drive does not demonstrate everything Solid Edge can do. Its purpose is to show you

how powerful and intuitive Solid Edge is, and to get you started so you can learn more on your
own.

Expect to spend about two hours working through this guide.



Introduction to part modeling

In this activity you will construct the model shown in the illustration above while learning
various synchronous modeling techniques, such as:

* Drawing sketches

* Constructing features

* Dimensioning model edges
» Working with PathFinder

* Editing features

You will also create a preliminary drawing of the 3D model using the Quicksheet capability in
Solid Edge.



Solid Edge Part Modeling Workflow Overview

You model parts in Solid Edge using the following basic workflow:

» Draw a sketch for the first feature.

* Add dimensions to the sketch.

» Extrude or revolve the sketch into a solid feature.

* Add more features.

« Edit the model dimensions and solid geometry to complete the part.
* Create a drawing.

Solid Edge is made up of several components called environments. These environments are
tailored for creating individual parts, sheet metal parts, assemblies, and detailed drawings.

The Solid Edge: Part environment allows you to construct a base feature and then modify that
base feature with additional features such as protrusions, cutouts, and holes to construct a
finished solid model.



Front Loader Files

Create a subdirectory on your system named Front Loader. Click the Solid Edge Files to support
the tutorial link, download the SE front loader files.zip file to the Front Loader directory, and

unzip the contents there.



Create a part file

Create

IS0 F‘%

IS0 ShEet Metal
IS0 Assembly

S0 Weldment
S0 Draft
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In the create section on the startup screen, there are commands to create new files based
on common templates.

Click ISO Part to create a new synchronous part file.

Step 1: model the base feature
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In the next few steps, you will draw a rectangle and then construct the base feature of the
model as shown above. You will draw the sketch on the XZ principal plane, indicated by

the base coordinate system.



Observe the base coordinate system
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The first step in drawing any new part is drawing the sketch for the base feature.
The first sketch defines the basic part shape.

You will first draw a sketch on one of the principal planes on the base coordinate system, and
then extrude the sketch into a solid.
What is the base coordinate system for?

The base coordinate system is located at the origin of the model file. It defines the principal x, v,
and z planes, and can be used in drawing any sketch-based feature.

Depending on the configuration of your computer, there may also be a view orientation
triad displayed in the graphics window. If so, the base coordinate system is the element
shown highlighted in the illustration below. The view orientation triad, which cannot be
selected, is for view orientation purposes only. For the remainder of this tutorial, the view
orientation triad will not be shown.
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Start the Rectangle command
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You will draw the rectangle on the XZ principal plane, indicated by the base coordinate
system.

On the command menu, at the top of the Solid Edge application, choose Home
tab—>Draw group—>Rectangle by 2 Points.
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B [ 1 Rectangle by 3 Points

&3 | Polygon by Center

The Rectangle command bar appears, and the behavior of the cursor changes to display
alignment lines.



Observe the alignment lines attached to the cursor

e Move the cursor around the graphics window and notice that alignment lines extend
outward from the cursor.

The alignment lines are oriented to the XZ principal plane on the base coordinate system.
The XZ principal plane corresponds to the front view.

The alignment lines indicate the orientation and position in 3D space in which sketch
elements will be drawn.

Observe the keypoint indicator

e Position the cursor over the origin point of the base coordinate system, as shown
above, but do not click.

Notice that a keypoint indicator symbol appears adjacent to the cursor.

This is IntelliSketch in action, which makes it easy to draw precisely, relative to other
geometry.



This keypoint indicator " is the endpoint indicator.

It appears when the cursor is over the endpoint of a line, a model edge, or in this case, the
origin of the base coordinate system.

e Click the left mouse button for the first point of the rectangle.

e Move the cursor to the right then up. The Rectangle command bar update to reflect
the current cursor position. Click the left mouse button for the second point of the

rectangle.
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e Click Home tab—>Select group-> Select. Click the bottom horizontal line.
The properties command bar appears.

e On the command bar enter 900 for the length.

e Repeat the previous two steps for the left vertical line and enter a distance of 700.

10



Observe the rectangle
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Take a few moments to observe that the rectangle displays as a shaded element.

The rectangle displays as a shaded element because the lines that form the rectangle
define a closed region.

In Solid Edge synchronous modeling, when 2D elements form a closed area, they are
called sketch regions.
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Prepare to construct the base feature
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In Solid Edge, you construct solid geometry using the Select tool (1) and grab and go handles,
such as the Extrude handle (2), to quickly transform 2D sketch geometry into a 3D solid (3).

Select the sketch region using QuickPick

e Choose Home tab—>Select group—> Select.
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e Position the cursor over the sketch region as shown above, and pause. Notice that the
cursor image changes to indicate that multiple selections are available.

e Right-click and the QuickPick list appears.

e Move the cursor over the different entries in QuickPick, and notice the different elements
highlight in the graphics window. QuickPick allows you to select what you want when

multiple selections are available.
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e Position the cursor over the entry in QuickPick that highlights the Region, and then click
to select it with the right mouse button.

QuickPick

¥4 sketch 1
Partl

-
~ Depending on the current settings on your computer, the sketch region may highlight as
a shaded element or only the edges may highlight.

Observe the on-screen tools
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Notice the following:
e A command bar (1) is displayed in the graphics window.
e An Extrude handle (2) is displayed on the sketch, near where you selected the sketch.

The command bar provides a list of possible actions and the available options for the
current action.
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The Extrude handle is used to construct the feature. Before you construct the feature, you
will learn more about the command bar.

Command bar overview
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The command bar is displayed when you select certain types of elements. Based on the
elements you select, the command bar presents a targeted set of Actions and Options.

Actions:

The Actions list is displayed on the left side of the command bar (1). For a sketch region,
the default action is to construct an extruded feature. You can select a different action
from the Actions list. For a sketch region, you can also specify that you want to construct
a revolved feature.

Options:

The options available for the current action are displayed on the remainder of the
command bar (2). For an extruded feature, you can specify whether material is added or
removed, the feature extent, and whether the feature is constructed symmetrically about
the sketch region.

You will explore some of these options as you work through the Test Drive.
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Ensure the proper options are set on the command bar

-7

e Pass the cursor slowly over the various options on the command bar.

Notice that tool tips are displayed that give you additional information about the options on
the command bar.

e On the command bar, ensure the following options on your computer match the
illustration:

(1) The Extent Type option is set to Finite.

(2) The Symmetric Extent option is set.
(3) The Treatments option is cleared.

Select the Extrude handle and define the base feature extent

e Position the cursor over the extrude handle, and when it highlights, click the left mouse
button.

e Move the cursor slowly and notice that the feature is drawn symmetrically on both sides
of the sketch as you move the cursor.

Also notice that a dynamic input box is displayed in the graphics window.
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e Type 1980 in the dynamic input box, and then press the Enter key to define the extent for
the feature, as shown below.

You have completed the base feature.

Observe the results

Your graphics window should resemble the illustration. Notice that a solid base feature is
displayed and that the sketch is no longer displayed.

When you construct sketch-based features in Solid Edge, the sketches are moved to the
Used Sketches collection in PathFinder after you construct a feature.

You will learn more about PathFinder in the next step.

16



Explore PathFinder

& Partl
= F*3 PMI
= [ 75, Dimensions
o [*1Linear 1
¥ Base
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= 52 Uused Sketches
0.2 Sketch 2

Take a few moments to explore PathFinder, located on the left side of the application
window.

PathFinder helps you evaluate, select, and edit the components that comprise the models you
create in Solid Edge.

e Click the ® symbols in PathFinder to expand the various collectors until your display
matches the illustration.

Notice the following in PathFinder:

e A feature’s collector that contains a Protrusion entry, which represents the base feature
you constructed.

e A Used Sketches collector that contains a Sketch entry for the sketch you used to
construct the feature.

When you construct sketch-based features, the sketches are moved to the Used Sketches
collector in PathFinder, where you can use them for subsequent features later.
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Save the part

e Onthe Quick Access toolbar, located at the top-left side of the application window,

click the Save button to save the work you have done so far. Enter Bucket for
the filename and navigate to the directory where you extracted the files earlier.

o

Step 1 completed

Congratulations, you have completed the first step in constructing a part, the base feature.
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Step 2: Chamfer the edge
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In the next few steps, you will construct the chamfered feature shown in the illustration.

e Choose Home tab—>Solids group—>Round drop down list->Chamfer Unequal
Setbacks.

Round'
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e The Chamfer Unequal Setbacks command bar is displayed. Select the Chamfer

Unequal Setbacks-Chamfer Options button. ==

e Inthe Chamfer Options, select 2 Setbacks and click OK.
[ m————" [ |

Chamfer Edge
(") Angle and setback {HCI E
@ 2 Setbacks IZ
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e Select the two faces as the faces containing the edge to chamfer. Select the front face
(1) and then the bottom face (2).

e Click the Accept button.

e Next, select the edge shown below as the edge to chamfer. Enter 550 in the setbackl
field and 838 in the setback 2 field. (Remember to use the tab key to navigate from
edit field to edit field).

o

e Click the Accept button, and then Finish to complete the chamfer.

®
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Observe the results

Your model should now resemble the illustration.

Step 2 completed

You have completed the chamfer feature.
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Step 3: Adding and editing PMI Dimensions.

PMI (Product Manufacturing Information) dimensions are dimensions directly placed on
a 3D Model. Solid Edge with Synchronous Technology actually allows you to use PMI
dimensions to drive and control the 3D geometry directly.

In history base modeling systems users dimension the profile geometry to control the
resulting 3D model. Upon doing so, if you do not apply the appropriate dimensions at
creation time, you return to the feature and add them or make whatever changes
necessary. Since features are dependent on each other in a history based system a user
may find parts of the model fail as the rest of the features rebuild. This is obviously
dependent on the edits a user makes and how the part was originally constructed.

In Solid Edge with Synchronous Technology you apply PMI dimensions directly to the
model at any stage you want. Of course, if dimensions are applied when a profile is
drawn they automatically become PMI dimensions when 3D geometry is created. Once a
dimension has been applied to the model, its value can be modified. However unlike
regular parametric dimensions, we are able to toggle the direction of the dimension. This
gives better control over which area of the part gets modified. Since there are no feature
dependencies, changes happen instantly and don’t adversely affect other areas of the
model. If you have the need to modify any critical distances, it is possible to lock
appropriate dimensions when necessary.
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The following image and corresponding table explain the color codes assigned to
dimensions.

|PMI dimension color codes
Color |Solve condition Dy_namlc Attached to
Edit?
|Blue |Free Yes Synchronous elements
Locked,
Red dimension Yes Synchronous elements
constrained.
Driven by other Ordered elements or
Purple di oy No. otherwise uneditable
imension
PMI
Purple Dr|_ven by a No Synchronous elements
Text variable
Not adequately
Brown |Not available No attached to any
element
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Within the PMI collector, different types of dimensions (linear, radial, angular, and etc.)
display unique symbols and element names on PathFinder. Also, their respective color
code is displayed

= [ (& Dimensions
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o [*}Linear 3
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In the next few steps, you will edit a few PMI dimensions.
&

You can you this command to place a dimension on one element or between two
elements.

e Choose Home tab—>Dimension group—>Smart Dimension.

e Position the cursor over the model’s edge, and when it highlights, click to select it.
Notice that dimension elements are attached to the cursor.
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e Position the cursor above the model, and click to place the dimension.

~ts

A dynamic input box is displayed near the cursor so that you can edit the dimension
value.

The dimension value on your model may be different than the illustration.

Edit the sketch dimension value

e Inthe dynamic input box, type 72, select the lock icon (1), and make sure the driving
end of the dimension is set to the right (2), and then press Enter.

EJCI S
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Observe the results

- 72

You will learn more about dimensions later in this test drive. For now, observe that the
dimension color is red, and that you were able to edit the dimension immediately upon
placement.

e While still in the Smart dimension command or if you have exited the command
#
Choose Home tab—>Dimension group—>Smart Dimension. |* *|

e Position the cursor over the model’s edge, as shown below, and when it highlights,
click to select it. Notice that dimension elements are attached to the cursor.
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e Position the cursor to the right of the model, and click to place the dimension.

<+

A dynamic input box is displayed near the cursor so that you can edit the dimension
value.

The dimension value on your model may be different than the illustration.

Edit the sketch dimension value

e Inthe dynamic input box, type 100, select the lock icon, and make sure the driving
end of the dimension (Red Arrow) points up, and then press Enter.

fele =]

e While still in the Smart dimension command or if you have exited the command

-

Choose Home tab—>Dimension group—>Smart Dimension.
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e Position the cursor over the model’s edge, and when it highlights, click to select it.
Notice that dimension elements are attached to the cursor.

0

e Position the cursor below the model, and click to place the dimension.

-0

A dynamic input box is displayed near the cursor so that you can edit the dimension
value.

The dimension value on your model may be different than the illustration.
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Edit the sketch dimension value

e Inthe dynamic input box, type 910, select the lock icon, and make sure the driving
end of the dimension (Red Arrow) is set to the right, and then press Enter.

fo.10.00 o IRIEZY
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e While still in the Smart dimension command or if you have exited the command
#
Choose Home tab—>Dimension group—>Smart Dimension. |* *|

e Position the cursor over the model’s edge, and when it highlights, click to select it.
Notice that dimension elements are attached to the cursor.

<+

e Position the cursor to the left of the model, and click to place the dimension.
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A dynamic input box is displayed near the cursor so that you can edit the dimension
value.

The dimension value on your model may be different than the illustration.

Edit the sketch dimension value

e Inthe dynamic input box, type 650, select the lock icon, and make sure the driving
end of the dimension (Red Arrow) points up, and then press Enter.

4
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Observe the results

You will learn more about dimensions later in this test drive. For now, observe that the
dimension color is red, and that you were able to edit the dimension immediately upon
placement.
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Step 4: Modify the model

In the next few steps, you will explore the various methods you can use to modify models
in Solid Edge.

First, you will explore using the grab and go tools, such as the Select tool and the steering
wheel to interact directly with the faces on the model.

Then you will edit the value of a dimension directly to edit the model.

Display the base coordinate system

When you modify synchronous models, any model symmetry that exists about the base
coordinate system is honored by default. When you constructed the base feature, you
constructed it symmetrically about the XZ plane of the base coordinate system.

e In PathFinder, click the check box adjacent to the Base entry to display the base

coordinate system.
[ Partl
F¥d P
{*: Base
[ |&] Base Reference Planes

The base coordinate system is displayed.
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Rotate the model

e Choose the upper left corner of the Quick View Cube located in the lower right corner of
the view as shown in the illustration to rotate the view.
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Select a model face

e The Select command should be active. If not, choose Home tab—> Select
group->Select.

e Position the cursor over the face shown above. When it highlights, click to select it.

Several tools are displayed that you can use to evaluate and control how the model reacts
to the modification:

e 3D Steering wheel
e The Command bar

e Live Rules

33



3D steering wheel

(1) Torus
(2) Tool plane
(3) Origin
(4) X axis
(5) Y axis
(6) Knob
(7) Z axis
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The steering wheel displays in a minimal state when selecting a face (1) and displays fully
exposed when selecting a feature (2). In a minimal state, only the primary axis appears. To fully
expose the steering wheel, click the origin and move it to an edge, keypoint or face of the model.

Rotating a face

Rotate a face by positioning the steering wheel’s axis on an edge. The axis becomes the
axis of revolution. Select the torus to begin dynamic rotation or type a rotation angle in
the dynamic input box.

Note You can lock and drag a graphic handle orientation. Hold the Shift key, click the
handle origin, and drag it to a desired edge or vertex.

e With the face highlighted and the steering wheel axis shown we will now prepare to
rotate the face.
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e To rotate the selected face, we will define a rotation axis. Drag the steering wheel origin
(1) to the edge shown (2). The axis must lie on an edge that the face rotates about.

e Click the steering wheel torus (1) to start the rotation. As the cursor moves, the rotation

angle tracks with the cursor. Move the cursor to the right and type 30 in the Dynamic Edit
box to define the rotation angle.

When an attempt to edit a dimension would cause a conflict with existing relationships an

information icon displays in the Dimension Edit Value dialog box i . If you position the
cursor on the icon, a detailed message explains how you can resolve the conflict using the
Live Rules panel, which appears when you edit a 3D dimension, and Solution Manager.

e The triangle attached to the cursor indicates a live rule is preventing this change. To
disable the live rule click on the face to suppress the lock to base live rule.

e Press <Esc> to accept the change.
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Add an Angle Dimension

e Choose Home tab->Dimension group—>Angle Between. X7

e On the menu bar select the Lock Dimension Plane E icon and select the face shown in
the illustration below.

e Place the dimension shown by clicking on the two lines (do not select any keypoints).
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Edit the sketch dimension value

e In the dynamic input box, type 83, select the lock icon, and make sure the driving end
of the dimension (Red Arrow) points up, and then press Enter.

Observe the results

Your model should now resemble the illustration.

Step 4 completed

You have completed the modification of the model.
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Step 5: Round the edges

In the next few steps, you will use the Round command to round three edges on the part.

e Choose Home tab—>Solids group—>Round. U

Select the first edge to round

e Select the edge shown in the illustration.

e When the dynamic edit box displays, type 150, and press the Enter key. (Note: The
illustration will not match what is displayed on your screen). The model has been
rotated up for clarity on edge selection for this command.

Select other edge to round and finish the feature

e While still in the Round command, make sure that the Selection Type is set to Chain

FEFESSS
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e Select the edges shown in the illustration.

|

e Inthe dynamic edit box, type 30, and press the Enter key.

Observe the results

Your model should now resemble the illustration.

Step 5 completed

You have completed the round feature.
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Return to default Isometric View

e Press Ctrl+l to rotate the view back to the default Isometric view.

Save the part

On the Quick Access toolbar, click the Save button ki to save the work you have done
so far.

Step 6: Placing a Shell Feature

In the next few steps, you will place a shell feature as shown.

l I_'
e Choose Home tab->Solids group—>Thin Wall. @

Select Faces to leave open

e Select the faces shown in the illustration to leave open.

e In the dynamic edit box, type 12, and press the Enter key.
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Observe the results

Your model should now resemble the illustration.

Step 6 completed

You have completed the shell feature.
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Step 7: Construct a hole

In the next few steps, you will construct a hole feature.

First, you will hide the base coordinate system and the existing dimensions using PathFinder, and

then rotate the view orientation.

Rotate the model

e Choose the upper left corner of the Quick View Cube located in the lower right corner of
the view as shown in the illustration to rotate the view.

Start the Hole command

Notice that the Hole command bar is displayed in the graphics window, and that a default

Choose Home tab—> Solids group—>Hole.

hole feature is attached to the cursor.
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Define the hole parameters
k=
e On the Hole command bar, click the Hole Options E button. The Hole Options
dialog box is displayed.

o Set the following hole properties:

-

Haole Cptions ﬁ

Standard: [ISD Metric "] . Saved settings:

Sub type: (Drill Size . = -
I - - ,]
Fit: [Exact
\

Hole extents:

&3
Hole depth:
50,80 mm

V bottom angle:

0.00®

/R I S

F 1

25 mim -

o Set the Diameter to 25.

o Ensure the Extents option is set to Through Next.

Estents

SIS

e On the Hole Options dialog box, click OK.

Notice that the hole attached to the cursor updates to reflect the hole properties you
specified.
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Position the hole feature

e Move the cursor over different faces of the model, and notice that a preview image of
the results are displayed.

e Position the cursor over the face shown in the illustration above, but do not click.
e Move the cursor over the lock symbol and click or press F3 to lock to the plane.
e Click to place the hole feature.

¢ Notice that a hole feature is still attached to the cursor. Since this is the only hole you
want to construct, right-click to finish placing holes.




Locating the hole with PMI dimensions

™1

e Choose Home tab—>Dimension group—-> Distance Between.

e On the menu bar select the Lock Dimension Plane icon and select the face
shown in the illustration below.

e Position the cursor over the model’s edge, as shown below, and when it highlights,
click to select it.
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e Position the cursor over the hole until the center is highlighted and you get the center
indicator @ shown.

e Position the cursor above of the model, and click to place the dimension, as shown
below.

ay 7 5

The dimension value on your model may be different than the illustration

A dynamic input box is displayed near the cursor so that you can edit the dimension
value.
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Edit the sketch dimension value

e Inthe dynamic input box, type 800, select the lock icon, and make sure the driving
end of the dimension points to the right, and then press Enter.

[+ [« [=]

e Right click to restart the dimension command.

e Position the cursor over the model’s edge, as shown below, and when it highlights,
click to select it.
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e Position the cursor over the hole until the center is highlighted as shown in the
illustration.

e Position the cursor to the right of the model, and click to place the dimension, as
shown below.

The dimension value on your model may be different than the illustration

A dynamic input box is displayed near the cursor so that you can edit the dimension
value.
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Edit the sketch dimension value

e Inthe dynamic input box, type 100, select the lock icon, and make sure the driving
end of the dimension points down, and then press Enter.

Observe the results

Your model should now resemble the illustration.
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Save the part

® On the Quick Access toolbar, located at the top-left side of the application window,
to save the work you have done so far.

click the Save button [ ¥%
A\ PR
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Step 7 completed

You have completed the hole feature.

Step 8: Pattern the hole

In the next few steps, you will create a hole pattern shown.
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Start the Rectangular Pattern command

Choose Home tab—> Select group—> Select

i}

, and select the hole from Pathfinder

Choose Home tab—>Pattern group—>Rectangular Pattern. [ﬁ’

Move the cursor over the model’s face which contains the hole, move the cursor
down and to the right as shown below and click to define the pattern’s profile.

In the dynamic edit box enter the following pattern parameters:
o X Count2 (Press the tab key to move between input fields)
o Y Count2
o X Distance 380 mm (Direction in which the arrow is pointing)
©)

Y Distance 200 mm

fom_
¥ Count: | B , 330.00 mm
¥ Count: 2 kT
3 r L .

200,00 mm
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Select the Accept icon on the Pattern command bar to finish the pattern.
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e Right click in the work area free of geometry to exit the pattern command.

Observe the results

Your model should now resemble the illustration.

Save the part

® On the Quick Access toolbar, located at the top-left side of the application window,
click the Save button ‘E to save the work you have done so far.

Step 8 completed

You have completed the pattern feature.
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Step 9: Construct another extruded feature

In the next few steps, you will construct the protrusion feature shown in the illustration.

You will draw a rectangular sketch on the XZ plane of the base coordinate system, and
then use the Select tool to construct the feature.

You will also learn how you can use the Keypoints options on the Extrude command bar
to control the extent of a feature relative to existing geometry.

Start the Rectangle by 2 points command

— 30

f 830 1 30w

You will draw a rectangle on the XZ plane, and then place dimensions on the sketch. Change the
view styles to Wireframe.



e On the ribbon menu, at the top of the Solid Edge application, choose the Home
tab—>Draw group->Rectangle by 2 Points.
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[5] | Rectangle by Center

(1 Redanagle by 2 Pain%

[l Rectangle by 3 Points
r

&3 | Polygon by Center

e Expand the plus sign in Pathfinder to the left of the Base Reference Planes, select the
Front (xz) plane. If the previous Sketch is still active, you will have to deactivate it
by pressing F3 or clicking the Lock icon in the window to set active the xz plane for
the rectangle by 2 Points.

AL
=
. . i Sketch
e Choose View tab—>Views groups—> Sketch View. view

e Choose View tab—> Style->Wireframe. @

e Position the cursor at the approximate location shown in the illustration below and
click for the first point of the rectangle. (Note: The line highlighted below and the on
element indicator).
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e Drag the cursor up and to the right and click for the second point of the rectangle.
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e Dimension and edit the sketch to. The 830 dimension is from the origin to the left
vertical edge of the rectangle; make sure you use the keypoint selection on the origin
selection and left vertical line of the rectangle.

e Choose Home tab—>Dimension group—>Smart Dimension.

— 30
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e Press Ctrl=I to rotate the view back to the default Isometric view.



e Choose View tab->Style->Shaded with Visible Edges. ﬁ

e Choose Home tab—> Select group—>Select L_ [} .

e Position the cursor over the Rectangle as shown, and use QuickPick to select the
region.

The command bar and the Extrude handle are displayed.

Set the Endpoint option on the command bar

e Position the cursor over the Keypoints button Liad
to display the Keypoints list.

on the command bar, then click
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e Inthe Keypoints list, click the Endpoint option.

The command bar should now match the illustration below with symmetric option on.

pe[ErE e 210 |-

Select the Extrude handle

-0

e Position the cursor over the Extrude handle, and click to select it.
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Set the feature extent and direction

e Position the cursor over the edge shown in the top illustration. The endpoint indicator displays
adjacent to the cursor, and then the vertex is located. Click to define the feature extent at this

point.

The feature is constructed.
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Observe the results

Your extrude feature should resemble the illustration.

Notice that the sketch dimensions now control the extruded feature.

Step 9 completed

You have completed the steps to create the protrusion feature.



Step 10: Chamfer the edge

In the next few steps, you will construct the chamfered feature shown in the illustration.

e Choose Home tab->Solids group—~> Round drop down list->Chamfer Unequal
Setbacks.

Q G| @@
a Draft EET _E

wall- %@ || b 6

&l | chamfer Equal Setbacks
|.-a Chamfer Unequal Setbacks —ql

e The Chamfer Unequal Setbacks command bar is displayed. Select the Chamfer

Unequal Setbacks-Chamfer Options button .
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e Inthe Chamfer Options, select 2 Setbacks and click OK.

-
Chamfer Opticns

Chamfer Edge o
© Angle and setback T/

b

@) 2 Sethacks

i

e Select the faces shown below as the faces containing the edge to chamfer. Using the
select tool select (1) the front face, (2) the bottom face.

e Click the Accept button.
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e Next, select the edge shown below as the edge to chamfer. Enter 14 in the setbackl
field and 88 in the setback 2 field.

o Click the Accept button, and then Finish to complete the chamfer.




Observe the results

Your model should now resemble the illustration.

Step 10 completed

You have completed the chamfer feature.



Changing the color of a model

In the next few steps, you will change the color of the model as shown in the illustration
above.

e Choose View tab->Style group—>Part Painter. D

e On the Part Painter command bar, select the drop down arrow for Style and select
Black, leave the drop down setting for Select, set to Body.

‘%‘ Style:[(Nune) vJ Selen:t[ElDdy vl [ Close I ‘
[ -

Mane)
Aluminum

Black (clear
Black. (cull)
Black (glass)
Blue

e Select the solid with the left mouse button and notice the color change.
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Save the part

e Onthe Quick Access toolbar, click the Save button to save the completed part.

Congratulations!

You have completed the modeling portion of this tutorial. Although there are more features and
dimensions that could be added to this part, you have learned the basic concepts required to
construct 3D models.
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Introduction to creating assemblies

This activity provides step-by-step instructions for building the assembly shown in the
illustration above. As you build this assembly, you will learn techniques such as:

Using PathFinder to manage the display of parts in the assembly.
Applying assembly relationships between parts.
Editing parts in the context of the assembly.

Creating exploded views of an assembly.
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Step 1: Observe the current assembly

z/

In the next few steps, you will take a few moments to familiarize yourself with the
assembly document.

You will learn how to highlight and select assembly components using PathFinder.

Open an assembly

Open Cirl+ O

g- 3[_.'

i_I Hew g
,%'

U=

:"/‘; i
e At the top-left side of the application window, click the Application button qjy to

display the Application menu.
e Onthe Application menu, click Open.
The Open File dialog box is displayed.

e Setthe Look In field to the Front Loader directory where you extracted the files
earlier.

e Set the File Name field to Front Loader.asm.
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e Click Open to open the file.

Display PathFinder

B Front Loader.asm

+ E Coordinate Systems

+ 4L Reference Planes
[CF Main Body.par:1

+ B Wheel Axle.asm:1

+ %: Piston Rod.asm:l

+ B! piston Rod.asm:2
(18 Right Fairing.par:1

PathFinder should already be displayed. If you do not see it, follow these steps to display
it.

e Click the Solid Edge Application button.
e Onthe Applications menu, click the Solid Edge Options button.
e The Solid Edge Options dialog box is displayed.

Click the Helpers tab, and ensure the Show PathFinder in the Document View option is
set.

You can use the PathFinder tab to review and edit the assembly structure, hide and

display assembly components, such as parts, subassemblies, coordinate systems, and
reference planes.
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Highlight the Main Body part

B Front Loader.asm
# [ ¥ Coordinate Systems
# [¥) 4 Reference Planes

(w3 : .

Main Body.pa
# V) B Wheel Axle.asm.
® (v) By} Piston Rod.asm:1
® ¥ B} Piston Rod.asm:2
[ !@._Right Fairing.par:1

® |nthe top pane of PathFinder, position the cursor over the Main Body.par entry, but
do not click.

Notice that the frame part display changes color in the assembly window. Move the
cursor away and notice that the display returns to the previous color.
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Select the Main Body part

H5 Front Loader.asm
1+ Coordinate Systems
<F Reference Planes
# [V B Wheel Axle.asm:1
# [ B, Piston Rod.asm:1
# [ B} Piston Rod.asm:2
[ !@ Right Fairing.parl

e In PathFinder, position the cursor over the MainBody part again, then click, and move
the cursor away.

Notice that the part color in the graphics window changes to a different color than in the
previous step.

Also notice that when you select the part, the bottom pane of PathFinder displays the
assembly relationships used to position the part. Since this was the first part placed in the
assembly, the relationship symbol that is displayed is the ground relationship.

O Main Body.par:l
#* Main Body.par:l
tleWheel Axle.asm:1l (rotation unlocked)
e Piston Rod.asm:l ([rotation unlocked)
tle Piston Rod.asm:2 [rotation unlocked)
> Piston Rod.asm:1  [0.00 mm)] [V510)
o Piston Rod.asm:2 (0,00 mm} [V715)
H4 Right Fairing.par:l (0.00 mm) [V723]
tle Right Fairing.par:1 [rotation unlocked)
tle Right Fairing.par:1 (rotation unlocked)

When working in assemblies, you can temporarily highlight components using
PathFinder, and you can also select them.
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Select the Wheel Axle assembly

5 Front Loader.asm

1+ Coordinate Systems

4k Reference Planes
F Main Body.parl

i Wheel Axle.asm:l

&,! Piston Rod.asm:1

%: Fiston Rod.asm:2
[0 Right Fairing.par:1

e In PathFinder, position the cursor over the Wheel Axle assembly, then click, and
move the cursor away.

Notice that when you select the Wheel Axle assembly, the bottom pane of PathFinder
displays the two assembly relationships used to position the part.

A mate relationship and an axial align relationship were used to position the part with

respect to the frame part. You will learn more about relationships when you place more
parts into the assembly.

Highlight the relationships in PathFinder

Lﬁ;\}vheel Axle.asm:l
3le Main Body.par:1 (rotation unlocked)
Front (x2) (0.00 mm) (V371)

(=) ~| ‘150 v [12 ~ | me |
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e Position the cursor over the first assembly relationship in the bottom pane of
PathFinder, but do not click.

Notice that the two Planes used to position the Wheel Axle assembly highlight in the
graphics window, along with a symbol (1) representing the relationship between them.

These display clues make it easy to evaluate how an assembly was constructed later.

Display the coordinate systems collection
e Inthe graphics window, click in free space to deselect the Wheel Axle assembly.

e In PathFinder, position the cursor over the "+" symbol adjacent to the Coordinate
Systems collection, and click the left mouse button.

F4 Front Loader.asm
ECnnrdinate Systems
‘H’ Feference Planes
CF Main Body.par:l
+ B Wheel Axle.asm:l
& B! piston Rod.asm:1
L B! Piston Rod.asm:2
[]'O3 Right Fairing.par:l

Notice that an entry for the Base coordinate system is displayed, as shown below.

B Front Loader.asm
= E Coordinate Systems
|- Base,
+ CH? Referenlanes
C¥F Main Body.par:l
+ B Wheel Axle.asm:l
+ B! Piston Rod.asm:1
+ 8.} Piston Rod.asm:2
[]'0O Right Fairing.par1

There is one Base coordinate system in an assembly document, located at the center of
the design space. Any additional coordinate systems you define are added to the
Coordinate Systems collection in PathFinder.
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Hide the coordinate system

B4 Front Loader.asm
= [+ [+ Coordinate Systems
DE Base

4k Reference Planes
CF Main Body.parl

B Wheel Axle.asm:l

B! piston Rod.asm:1

B! piston Rod.asm:2
[0 Right Fairing.par:l

+

+

+

e In PathFinder, position the cursor over the checkmark adjacent to the Base entry, then
click to hide the coordinate system.

The coordinate system is hidden in the graphics window.

Notice that the text in PathFinder for the Base entry has changed color.
You can use the checkboxes in PathFinder to display and hide assembly components.

The component entries in PathFinder also change color to indicate the current status of
the assembly components.
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Fit the view

Choose Fit E to fit the contents of the view to the graphics window.

Step 1 completed

Congratulations, you have completed the first step in this activity: You were shown the
current state of the assembly and learned about PathFinder options in an assembly
document.
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Step 2: Position a sub-assembly in the main assembly

\ L

In the next few steps, you will place a Arm Skid Plate assembly onto the Front Loader
assembly.

You will learn how to find and select parts using Parts Library.

You will learn how to position parts using assembly relationships and the Assemble
command bar.

Positioning Overview

\ L

To position parts or sub-assemblies into an assembly, you apply a variety of assembly
relationships.

For the name Arm Skid Plate sub assembly, you will apply a mate relationship and two

axial aligns relationships to fully position the Arm Skid Plate with respect to the Main
Body and Piston Rods.
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Solid Edge provides a tool called FlashFit that allows you to apply each of these
relationships, without having to specify the exact relationship type you want to use.

In the next few steps, you will use FlashFit to fully position the name plate as shown
above.

Display the Parts Library pane

You will be using both the PathFinder and Parts Library panes to select and position parts
in the assembly.

To make it easier to see the contents of the Parts Library and the PathFinder panes, you
will maximize their size.

e Onthe left side of the Solid Edge window, move the cursor over the Parts Library tab,
but do not click.

Parts Library ¥ B X

Training b |

ABIQIN SHEH ﬁl
]
B
&)
®
&
-
&
a

EB.ﬂ'.rm Skid Plate.asm
EI Arm.par

EI Axle.par

EEICagE Seat.asm
EI Cage.par
EFant Loader.asm

The Parts Library tab is displayed.

e Move the cursor into the graphics window, away from the Parts Library pane, and
notice that after a moment the Parts Library pane closes.

As long as the Parts Library pane is displayed and the cursor is over it, it will continue to
display.

e Now move the cursor over the Parts Library tab and click.
The Parts Library tab is displayed again.

e Move the cursor away from the Parts Library pane, and notice that the pane remains
displayed.
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e Now move the cursor into the graphics window, away from the Parts Library pane,
and click.

The Parts Library tab closes.

In the instructions that follow, you will work with information in the Parts Library pane.
Use whichever method of displaying the pane leaves you more comfortable.

Set the Parts Library folder

If the working folder on the Parts Library tab is not the Solid Edge Training folder, do the
following:

e Onthe Parts Library tab, click the arrow on the right side of the Look In control and
then browse to the Front Loader directory where you extracted the files earlier.
However, your system administrator may have chosen a different location.

Similar to Windows Explorer, you can define how you want to view the files listed in the
Parts Library: Large Icons, Small Icons, List, and Details.

e On the Parts Library tab, click the Views button, and then set the Details option.
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If You Have Trouble Placing Parts

'\ =

In the next few steps, you will place and position the nameplate part as shown.

For the remainder of this test drive, if you position a part incorrectly or lose your place
while positioning a part, press the <Esc> key.

Then use the Select tool command on the Home tab to select the part, and press the
Delete key to delete the part.

You can then back up to the step where part placement begins, and try again.

Place the Arm Skid Plate assembly

\ e

e Display the Parts Library.
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e Inthe file list area on the Parts Library tab, select the file named Arm Skid Plate.asm,
hold down the left mouse button, drag the file into the assembly window, and then
release the mouse button at the approximate position shown above.

The Arm Skid Plate is placed in the assembly.

Examine the command bar

3

Bl

2 l—llgl‘lﬁq

E] G| | Flip ‘

I Creating Relationship 1 '[;}l 0.00 ram -

e

When you placed the name plate part into the assembly, the command bar was displayed.

Beginning at the left, examine the command bar, and notice the options:

&
',’ )| The Place Part command is active.

|

ﬁ : The Occurrence Properties button displays the Occurrence Properties dialog box.
You can use this dialog box to define whether the part is displayed in higher level
assemblies, counted in parts lists, and so forth.
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=1

.l’/[j : The Construction Display button allows you to display or hide elements for the part
you are placing, such as reference planes, sketches, and construction surfaces. This can
make it easier to position certain types of parts.

| Creating Relationship 1 [ 7] The Relationship List displays the relationships used to
position a part. When editing the position of a part after placement, you can select the
relationship you want to redefine from the list.

59 o : : o
: The Relationship Types option allows you to select which assembly relationship
option you want to use for positioning a part.

!E._:
= : The Options button displays the Options dialog box. You can use this dialog box to
set the FlashFit options, Reduced Steps option, and so forth.

| |

I—u : The Activate Part button lets you select a part and activate it. When placing a
subassembly using FlashFit or the Reduced Steps mode, the parts in the subassembly
must be active before you can select a face. If the subassembly is not already active, you
can use the Activate Part button on the Assemble command bar to activate the placement
part in the subassembly which contains the face you want to select.

— || 1—
: The Floating and Fixed Offset buttons allow you to define whether the offset
value is defined using another relationship you apply later (Floating Offset) or has a fixed
numeric value based on the relationship you are currently defining (Fixed Offset).

J0.00 mm =1 The Offset Value box allows you to type the fixed offset value you want.

e @ : The Unlock Rotation is set. With this opti

[r— : . ption, you can use another assembly
relationship to define the rotational orientation of the part. For example, you can apply an
angle relationship. The Lock Rotation option fixes the rotational orientation of the part.
This option is useful when the rotational orientation of the part is not important, such as
for a bolt being positioned in a hole.

The Flip button repositions a part to the opposite side of a face, changing a mate
relationship to a planar align relationship.
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Review the part placement options

I1ze FlazhFit as the default placement method
|lze Reduced Stepz when placing parts

[ ] &utomatically Capture Fit when placing parts
[ ]Use distance between faces as default offset

FlazhFit

Locate the following element types:
Flanar faces
Cylindrical faces
Circular edges
[] Linear edges
[ ]Paints

Dimensions
Show all dimenzions

e On the command bar, click the Options button. E

e On the Options dialog box, ensure that the options on your computer match the
illustration, and click OK to dismiss the dialog box.

Notice that the FlashFit option allows you to specify what types of faces you want
FlashFit to recognize.

For this activity, and most part positioning scenarios, the FlashFit settings shown works
well.
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Mate the Arm Skid Plate assembly to the Main Body part

When you select faces for the first assembly relationship, Solid Edge repositions the part you are
placing based on the approximate positions on the faces you select on the placement part and the
part in the assembly.

The first relationship you will use FlashFit to apply is a mate relationship.

A mate relationship positions a part by orienting two planar faces so that they face each other.

Mated faces can touch or be offset from each other. For this part, the default offset value of zero,
where the parts touch, is the appropriate option.

e On the Assemble command bar, in the Relationship Types list, ensure that the

70
FlashFit option is active.
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Use QuickPick to select the planar face on the name plate

e Position the cursor over the face shown highlighted in the top illustration, stop moving the
mouse for a moment, and notice that the cursor image changes to indicate that multiple
selections are available. Also notice that the cursor image indicates which button you must

click to display the QuickPick list. The default is to right-click to display QuickPick. [%”““
¢ Right-click, and the QuickPick list is displayed. Move the cursor over the different entries in

QuickPick, and notice that different elements of the model highlight. QuickPick allows you to
select the element you want, the first time, without having to reject unwanted elements.

e Use QuickPick to highlight the planar face shown in the bottom illustration, and then left-
click to select it.

QuickPick

1 Plane (Protrusion 3)
[1 Plane {Protrusion 2)

1 »
1 cylinder (Round 5) h
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Select the mating face on the Main Body part

If the QuickPick cursor displays, but the proper face is highlighted, you can bypass QuickPick by
left-clicking.

o Select the front face of the Main Body part, as shown in the illustration.

Observe the result

The mate relationship repositions the Arm Skid Plate subassembly in the assembly.

Because you have only applied one assembly relationship, the position of your Arm Skid Plate
subassembly might be different than the illustration.
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Axially align the Arm part with the Main Body

In the next few steps you will use FlashFit to apply axial align relationships between the
hinge hole on the arm part with the hinge stud on the Main Body part, as shown in the

illustration.

Select the cylindrical axis to align

QuickPick

[] Plane (Protrusion 3)
™. Edge {(Haole 1}

i m
™. Edge Hole 1)

™. Edge {(Round 5)

1 Axis

[] Plane (Protrusion 4)
™., Edge (Round 5)

e Use QuickPick to select the cylindrical face shown in the illustration.

You will align this cylindrical axis with the cylindrical axis on the Main Body.
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Select the cylindrical axis on the Main Body

e, . e

e Select the cylindrical axis on the Main Body part as shown in the illustration.

Observe the result

Although the Arm Skid Plate subassembly is now position on the Main Body stud.

In the next steps, you will apply another axial align relationship to position the Arm Skid
Plate subassembly.
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Axially align the Arm part with the Piston part

In the next few steps you will use FlashFit to apply axial align relationships between the
pin hole on the Arm part with the pin on the Piston part, as shown in the illustration.

Select the cylindrical axis to align

QuickPick
[ Plane {Protrusion 3)
*.. Edge (Hole 2)

]

[] Plane ¥erotrusion 3)
", Edge (Hole 2)

' Axis

™. Edge {Hole 2}

[] Plane {Protrusion 4)
[] Plane {Protrusion 4)
" Edge (Round 5)

I Axis

Arm.par:1

e Use QuickPick to select the cylindrical axis shown in the illustration.

You will align this cylindrical face with the cylindrical face on the Piston.
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Select the cylindrical axis on the Piston

e Select the cylindrical axis on the Piston part as shown in the illustration.

Observe the result

|

Although the Arm Skid Plate subassembly is now position on the Main Body stud.

In the next steps, you will apply another axial align relationship to position the Arm Skid
Plate subassembly.
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Axially align the Arm part with the other Piston part

In the next few steps you will use FlashFit to apply axial align relationships between the
pin hole on the Arm part with the pin on the Piston part, as shown in the illustration.

Select the cylindrical axis to align

%;_
QuickPick =

i

[] Plané¥Protrusion 7)
™. Edge {Hole &)

[ Plane {Protrusion 5)
[ Plane {Protrusion 5)

Arm.par:1
— /

e Use QuickPick to select the cylindrical axis shown in the illustration.

Ll

You will align this cylindrical axis with the cylindrical axis on the Piston.

90



Select the cylindrical axis on the Piston

.

e Select the cylindrical axis on the Piston part as shown in the illustration.
e Right mouse click to complete the placement. The reason for this is action is the Arm
Skid Plate subassembly is design to have degrees of freedom to move up and down.

If it was fully constrain the Arm Skid Plate assembly would have changed display
from transparent to opaque when all degree of freedom are satisfied.

Observe the result

z \ .

The Arm Skid Plate subassembly is now position on the Main Body.
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Use PathFinder to review the assembly relationships

f4 Front Loader.asm
= ﬁ Coardinate Systems
(| b Base

4 Reference Planes
CF Main Body.par

B Wheel Axle.asm:l

2.} Piston Rod.asm:1

%: Piston Rod.asm:2
[J/0 Right Fairing.par:1

[ Arm Skid Pkate.asm.'],[;\\S

e In the top pane of PathFinder, click the Arm Skid Plat.asm:1 entry, as shown above.

Notice that the relationships you applied display in the bottom pane of PathFinder, as
shown below.

B Arm skid Plate.asm:l
4 Main Body.parl (0,00 mm) [VS07)
e Main Body.parl [rotation unlocked)
te Fiston Rod.asm:1l [rotation unlocked)
te Fiston Rod.asm:2 [rotation unlocked)

Save the assembly

z\

e Onthe Quick Access toolbar, choose Save to save the work you have done so
far.
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Step 2 completed

Z \ .

You have finished adding a subassembly to the assembly and positioning it with
relationships.

Step 3: Position another sub-assembly in the main assembly

.

>

In the next few steps, you will place a Cage Seat assembly onto the Front Loader
assembly, as shown above.




Place the Cage Seat subassembly

\ =

e Display the Parts Library.

e Inthe file list area on the Parts Library tab, select the file named Cage Seat.asm, hold
down the left mouse button, drag the file into the assembly window, and then release

the mouse button at the approximate position.

The Cage Seat subassembly is placed in the assembly.
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Select the mating edge on the Cage Seat

QuickPick =]

™. Edge (PatternOccurrence_1)
1 Plane (Thin-wall 1)
] Cylinder (PatternOccurrence_1)

e pacenocarece o)
o Planrntrusinn 1)

= =

N

If the QuickPick cursor displays, but the proper face is highlighted, you can bypass QuickPick by
left-clicking.

e Select the bottom circular edge of the Cage part, as shown in the illustration.

Select the mating edge on the Main Body part

If the QuickPick cursor displays, but the proper face is highlighted, you can bypass QuickPick by
left-clicking.

e Select the bottom circular edge of the Main Body part, as shown in the illustration.
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Observe the result

Z

>

The mate relationship fully defines the Cage Seat subassembly. Because FlashFit’s
placement logic when you select circular edge to circular edge results in an Axial align and
Mate or Planar Align, which satisfied all degrees of freedom.

Save the assembly

s

e Onthe Quick Access toolbar, choose Save ki to save the work you have done so
far.




Step 3 completed

You have finished adding a subassembly to the assembly and positioning it with
relationships.

Step 4: Position a part in the main assembly

zr\

In the next few steps, you will place a Bucket part onto the Front Loader assembly.
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Place the Bucket part

Z

>

e Display the Parts Library.

e Inthe file list area on the Parts Library tab, select the file named Bucket.par, hold
down the left mouse button, drag the file into the assembly window, and then release
the mouse button at the approximate position.

The Bucket part is placed in the assembly.




Select the mating face on the Bucket

QuickPick

If the QuickPick cursor displays, but the proper face is highlighted, you can bypass QuickPick by
left-clicking.

e Select the back face of the Bucket part.

Select the mating face on the Skid Plate part

)

If the QuickPick cursor displays, but the proper face is highlighted, you can bypass QuickPick by
left-clicking.

e Select the front face of the Skid Plate part.

99



Observe the results

N ——

The mate relationship repositions the Bucket part in the assembly

Because you have only applied one assembly relationship, the position of the Bucket
might be different than the illustration.

Select the cylindrical axis to align

[ QuickPick

i
. Edg
] Plane
] Plane

Bucket?.par: 1

e Use QuickPick to select the cylindrical axis shown in the illustration.

You will align this cylindrical axis with the cylindrical axis on the Skid Plate.
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Select the cylindrical axis on the frame

e Select the cylindrical axis on the Skid Plate part as shown in the illustration.

Observe the result

® The Bucket is still free to pivot around the hole’s axis and will require one more axial
alignment relationship.
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Select the cylindrical axis to align

' QuickPick =]

| ] Plane
™. Edge
i m
™. Edge
[] Plane

Bucket2.par:1

e Use QuickPick to select the cylindrical axis shown in the illustration.

You will align this cylindrical axis with the cylindrical axis on the Skid Plate.

Select the cylindrical axis on the frame

e Select the cylindrical axis on the Skid Plate part as shown in the illustration.

e Right mouse click to complete the placement.
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Observe the result

The Bucket is now positioned in the assembly.

Save the assembly

On the Quick Access toolbar, choose Save

far.

zr\

zr\
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to save the work you have done so



Step 4 completed

z\

You have finished adding a Bucket part to the assembly and positioning it with
relationships.

Step 5: Duplicating Parts or Subassemblies

When building assemblies, you often need to place parts and subassemblies multiple
times in a pattern or mirror arrangement. For example, nuts, bolts, and other fasteners are
placed in a rectangular or circular pattern on the parts they are fastening together.

Patterning parts

You can use the Pattern Parts command to quickly copy one or more parts and
subassemblies into a pattern arrangement. You can also add an existing part pattern to a
new part pattern.

The patterned parts are not positioned using assembly relationships, but according to a
pattern feature on a part or assembly sketch.
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z m . >
E

N

Step 5: Creating an Assembly Patterns

e Choose the Home tab—>Pattern group—>Pattern. a

e When prompted to select the parts to be included in the pattern, select the Wheel
Axle.asm file shown and accept.

z

a N
1

e

& i

\HJA
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e When prompted to click on the part or sketch that contains the pattern, click the Main
Body.par as shown.

e When prompted to click on the pattern, select the pattern as shown.
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e Click Finish. The pattern is placed.

&

Observe the Results

y
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Step 5: Completed

Z m . -
b

Mirroring parts

You can use the Mirror Components command to quickly copy one or more parts and
subassemblies into a mirror arrangement around a reference plane you select.

In the next few steps, you will learn how to duplicate a part or subassembly in the top

level assembly. There are many ways to accomplish this; however in this test drive we
will utilize mirror.
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Display a Hidden Part Component

e In PathFinder locate the Right Fairing.par. Select check the empty box to the left of
the component as shown in the illustration below.

F5 Front Loader.asm B Front Loader.asm

& Coordinate Systems E Coordinate Systems

4L Reference Planes 4L Reference Planes
CF Main Body.par:l CF Main Body.par:1

B Wheel Axle.asm:l B Wheel Axle.asm:l

.} pPiston Rod.asm:1 2! piston Rod.asm:l

! piston Rod.asm:2 2! piston Rod.asm:2
[/ Right Fairing.par: —_— [ Right Fairing.par:1

B Arm Skid Plate.asn: %ﬂi‘ Arm Skid Plate.asm:l

fh Cage Seat.asm:l fh cage Seat.asm:l
O Bucket2.pari O Bucket2.par:l

FEH Pattern_1 8 Pattern_1

Step 5. Creating an Assembly Mirror

: |£I I11|
e Choose the Home tab—>Pattern group—>Mirror Components. |

e When prompted to select the components to be mirrored, select the Right Fairing file
shown and accept.
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e When prompted to click on an assembly reference plane to mirror about, expand the
Reference Planes in PathFinder and select Front (xz) plane.

B9 Front Loader.asm
E Coordinate Systems
= 4k Reference Planes

E ] Top [xy)

L1 Right [yz)

CF Main Body.pdiil

B Wheel Axle.asm:l
%: Fiston Rod.asm:l
%: Fiston Rod.asm:2
B Arm Skid Plate.asm:l
Fh cCage Seat.asm:l

O Bucket2.parl
P Pattern_1

e When the Mirror Components dialog displays, click the Output file field and type
Left Fairing, and click OK.

Mirror Components @
ﬁ'_‘ Note: Overriden actions are indicated with a shaded cell. Edit pending items manually or dick the
Change Pending to Mirror button to change all in a single step.
Components Action Adjust Cutput File Folder Template
(3 Right Fairing.parl Mirror Left Fairing.par C:\Users\t...\Reset Mo Assy Design\  Iso Part.par
0K ] I Cancel I I Help

e Click Finish. The mirror is placed
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Rotate the model

e Choose the upper left corner of the Quick View Cube located in the lower right corner of
the view as shown in the illustration to rotate the view.

Observe the Results

Notice that the left fairing is mirrored to the other side of our assembly and will represent
itself as a unique component in the Bill of Materials when we create an assembly
drawing.
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Step 5: Completed.

Step 6: Create an exploded view of the assembly

In the next few steps, you will create an exploded view of the assembly.
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Prepare to create an exploded view of the assembly

e Hold down the Ctrl key on the keyboard, then press the | key to rotate the view back
to the default Isometric view.

e Choose Tools tab—>Environs group>ERA. %

The system displays menus and commands specifically tailored for creating exploded
views, renderings, and animations of an assembly.

If the Explode Pathfinder window obscures your view, you can close the window.
You do not need it for this test drive.

Start the Automatic Explode command

You will use the Automatic Explode command to begin defining the exploded assembly
view.
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The Automatic Explode command explodes assemblies based on the relationships applied
between parts. In assemblies where the components are positioned using mate or axial
align relationships, the Automatic Explode command quickly gives you excellent results.

-
e Choose Home tab—>Explode group->Auto Explode.

e On the Automatic Explode command bar, ensure that the Select option is set to Top-
Level Assembly.

Yl T op-level aszembly

e On the command bar, click the Accept button.

Set the Automatic Explode Options

When using the Automatic Explode command on an assembly that contains
subassemblies, you can specify whether the parts in subassemblies are exploded or
grouped together as a single unit.

e For this assembly, you want to explode the subassemblies also.

e On the Automatic Explode command bar, click the Automatic Explode Options

[ =
button. =

e Onthe Automatic Explode Options dialog box, clear the Bind All Subassemblies
option. When you clear this option, the parts in subassemblies are exploded.

Automatic Explode Options

[]gind all subassemblies K

Explode Technique Cancel

(%) By subassembly level
By individual part

III%

Help

e Ensure the By Subassembly Level option is set as well, and then click OK.
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Create the automatic explosion

\\/%

e On the command bar, click the Explode button.

The system processes, and then displays the exploded view.
e On the command bar, click the Finish button.

Notice that the display is good, but it would be easier to visualize the exploded view on a
drawing sheet if the exploded view was more compact and exploded realistically.

e Exit the ERA environment and close the file.

Opening the completed exploded assembly

Dpen Ctrl+ 0O

-
Y
=
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@

e At the top-left side of the application window, click the Application button 0

display the Application menu.
e Onthe Application menu, click Open.
The Open File dialog box is displayed.

e Set the Look In field to the Front Loader directory where you extracted the files
earlier.

e Set the File Name field to Front Loader-EXPLODED.asm. Click Open.

In this assembly file, the exploded view has been created and modified to a better
exploded configuration. We will utilize this configuration for creating an exploded
assembly drawing.

Go to the ERA environment

e Choose Tools tab—>Environs group>ERA. @

Selecting an assembly configuration

e Choose Home tab—->Configurations group—>Drop down

Z -

b5

Configurations
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e Select the EXPLODED configuration and press OK.

-

[ Mew ] [ oK ][ Cancel

Notice the exploded view has better spacing between components and is now ready for
placement on an exploded drawing.

Observe the results
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Animating the exploded assembly configuration

>

Animation

e Choose Home tab—> Animate group—> Animation Editor. @ Editor

e Examine the Animation Editor.

The right pane is the time line for each of the animation events. A motor was defined
previously in this assembly. Controls for playing the animation are displayed.

Speed: E] EE] E] Time: 00:00:00 Frame: 0 E]

The left pane displays the animation events, and the right pane displays the event
duration bars. These can be used to define and sequence the events of the animation.

El[FNEE

&h Camera
QE Motors

E Explosion
¥ Appearance
o Paths

4 L

| »

4

¢ Right-click the Explosion event and then click Edit Definition.

El[FNEES

[ E—

& Camera
&4 Motors

. Explosion

M Appearance
o Paths

4 L

Edit Definition %

CEE
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e Set the parameters as shown. Click OK when finished.

Explosion Properties ﬁ

Configuration Initial State

IUse Explode from configuration: @ Collapsed

| EXPLODED - ) Exploded
\ Speed

i@ Common velodty for all parts: 1
(") Explosion duration 1 seconds per event

Animation Order

1z 21
@ Innermost first: |]—|:D (71 Qutermost first: [I:I—D

[ ()4 ” Cancel H Help ]

e Set the Speed control to 4X speedi (9 ~] (1)) [»] m | [sm][ 1] and press play
]

Closing the ERA environment

e Choose Home tab—>Close group—~>Close ERA i to return to the main Assembly
environment.
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Save the assembly

5%

e On the Quick Access toolbar, choose Save @ to save the completed assembly.

Step 6: Completed

%

You have completed the assembly portion of this test drive.

Although there are many more options available in the Assembly environment, you have

learned the basic concepts required to build, explode, and animate an assembly in Solid
Edge.
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Step 7: Create a drawing

In the next few steps, you will create an exploded view drawing of the assembly.
You will also place a parts list on the drawing.

Start the Create Drawing command

/ \v—Y\ ,“
e At the top-left side of the application window, click the Application button \1‘_,_/ to
display the Application menu.

e On the Application menu, point to New, the click Drawing of Active Model

e The Create Drawing dialog box is displayed.

=
New . New
D Assembly of Active Model
% Open Chrl=0) m ﬁ Creates a new assembly containing the current model.
-k'y Recent Documents g Drawing of Active Model
4&, Creates a new drawing from the current model.
[- i SAve
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Set the Create Drawing options

e On the Create Drawing dialog box, click Browse.

Create Drawing \ @

e

Template | =aEElE E1aRslis Browse... |

Fun Drawing View Creation Wizard

[ QK. ][ Cancel H Help ]

e — E 3 s — W

e On the New dialog box, click the More tab, and select the ansi mm draft.dft template
and click OK.

e On the Create Drawing dialog ensure the Run Drawing View Creation Wizard option

is set, and then click OK.

A new drawing document is created, with drawing views of the part created and
positioned.

Set the Drawing View Creation Wizard options

Solid Edge transitions to the Draft environment and creates a new Draft document, using
the template specified in the Set the Create Drawing options dialog box. Solid Edge also
displays the Drawing View Creation Wizard, which helps streamline the process of
placing views of 3D models on a drawing.

The view of the assembly that you will place on the drawing is the exploded view of the
assembly that you saved a few steps ago.

122



e On the Drawing View Creation Wizard command bar, select Draw View Wizard

. kS| . . . : : . .
Options . On the Drawing View Creation Wizard dialog in the field labeled
.cfg, PMI model view, or Zone, click the list and select the EXPLODED view that
you saved earlier.

ra !

Drawing View Creation Wizard

Assembly Drawing View Options
.cfg, PMI model view, or Zone:

|4 ExPLODED -

Indude PMI dimensions from model views

Indude PMI annotations from model views

[] Uze simplified aszemblies [ Uge simplified parts
For all subassemblies For all parts
Based on configuration Based on configuration

For top assembly

[ create Draft Quality drawing views

View quality: | 2 Activate parts for dimensioning

Derive Tisplay as Reference” from Assembly

Show assembly features Show tube centerlines
Show hidden edges in: Show edges of hidden parts in:
COrthographic views COrthographic views
[T Pictorial views [T Pictorial views
Show tangent edges in:
[ | orthegraphic views
Pictorial views
[ QK ” Cancel ] [ Help ]
L A

e Onthe Drawing View Creation Wizard, click Ok.

e Onthe Drawing View Creation Wizard command bar, set the scale value to 0.050 and
press the Tab key.

e Onthe Drawing View Wizard command bar, select Draw View Creation Wizard

Shading options D and select Shaded with Edge.
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Position the view on the sheet

When the Drawing View Creation Wizard closes, a rectangle representing the view that
will be created is attached to the cursor. The view will be placed wherever you click.

e Position the view approximately as shown above, and click to place it.

Observe the result

Notice that an exploded view of the assembly is placed in the new drawing document and
that the display of the drawing view is shaded with visible edges displayed.
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Start the Part List command

In the next few steps you will place a parts list of the assembly on the drawing sheet.

You will also place balloons on the exploded view automatically using the Parts List
command.

=
e Choose Home tab—>Tables group—>Parts List.

Set the command bar options

7

:_i% Mormal - |%|

On the Parts List command bar, ensure that the Link to Active option is set, as shown
above
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Select the drawing view

e Inthe graphics window, position the cursor over the drawing view, then click to
select it.

¢ Notice that additional options in command bar are activated after you select the drawing
view.

Set the parts list and balloon properties

%A
e Onthe Parts List command bar, click the Properties button. [E=

e Onthe Parts List Properties dialog box, click the List Control tab, then set the Atomic
List (all parts) option.

(3 Top-level list top-level and
expanded components

(= Atomic List [all parts)

[ [Bwpand weldment subaszemblies

e Click the Balloon tab, and then clear the Item Count option.

e Click the columns tab.
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Notice that you can click a property in the lower list, and then click the Add Column
button to add a property to the Columns list. These are the properties that will be
displayed in the properties table. You can use the Move Up and Move Down buttons to
change the order of the columns, and you can use the Delete Column to remove columns.

e Use these controls to define these columns:
Item Number
Document Number
Title
Quantity

e Click OK.

Finish the parts list

L
Rl

e A rectangle representing the parts list table is attached to the cursor. Position the table
as shown, and click to place it.

Notice that the parts list and balloons are placed on the drawing sheet, and an alignment

shape is displayed around the view, with the balloons connected to the shape. You can
manipulate the shape to reposition the balloons.
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Observe the parts list

ltern | Docurnent Number Title Quantity
Nurnber

I SEQOOI hAAIM BODY I
2 sEQ00Z A¥LE 2
3 SEQ003 Rik 4
4 SEQ0O4 TIRE 4
5 SEQ00S PISTON 2
g SEQ00G RGD 2
T SEOOOT RIGHT FAIRING I
8 SEQOCE ARM I
5 SEQ00S SKID PLATE I
1d SEQOOID CAGE I
I SEQOOI SEAT I
12 SEQO0IZ BUCKET I
|3 SEQO0I3 LEFT FAIRING I

e On the Viewing commands toolbar, choose Zoom Area , then zoom in as shown in
the illustration.

e After you have resized the view area, right-click to exit the Zoom Area command.

Notice that the parts list contains rows for each part in the assembly and columns for the
Item Number, Document Number, Title, Material, and Quantity.

You can configure parts lists to meet your company’s requirements.
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Step 7: Completed

Save the drawing

e Onthe Viewing Commands toolbar, choose Fit Elto fit the drawing sheet to the
view.

e On the Quick Access toolbar, click the Save button.

e On the Save As dialog box, accept the default filename of Front Loader-Exploded.dft,
then click the Save button to save the draft document.
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Congratulations!
You have completed your first assembly and assembly drawing in Solid Edge.

To learn more about Solid Edge with Synchronous Modeling Technology, you can do the
following:

e Place additional PMI dimensions on the model geometry and edit the model to
view the results.

e Use the steering wheel to edit different features of the model until you understand
more of the options available.

e Select Solid Edge Help from the Help menu, and explore topics that are related to
the subjects described in this Test Drive.

In the next section of this Test Drive you will build and create a detailed drawing of the
bucket and learn more about creating 2D drawings.
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Introduction to detailed drawing
production

i

This activity provides step-by-step instructions for creating a 2D drawing from a 3D part
model. As you create this drawing, you will learn techniques such as:

e Defining the size of the drawing sheet you want to use.
e Controlling the projection angle.

e Placing different types of drawing views.

e Placing dimensions and annotations.

e Editing the part model in the context of the drawing.

e Updating the revised drawing.
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Start the Create Drawing command

At the top-left side of the application window, click the Application button to display the

Application menu.

On the Application menu, click New. On the New dialog box, select ANSI Metric as
the Standard then select the ansi mm draft.dft template and click OK.

"
1| New @
4 Standard Templates Edit List... P Preview:
AMNSIInch s
TR
s Dm_, . ansi metric ansi metric ansi metric ansi metric —
DIN Metric assembly.asm weldment.asm) [EEla part.par
ESKD Metric
GB Metric @
150 Metric - _
Metric
Nailboard ES
QuickSheet
Reports
Symbol
UNI Metric
OK ] ’ Cancel ] ’ Help

Step 1: Choose the part model and place the initial drawing views

N

In the next few steps, you will choose the 3D part model and place the initial drawing
views on the drawing sheet using the Drawing View Wizard.

You will also learn how to move drawing views on the drawing sheet.




Choose a part model to place on the drawing sheet

Choose Home tab—>Drawing Views group—->View Wizard.

e Inthe Select Model dialog box, do the following:

e Set the Look In field to the Front Loader directory where you extracted the files
earlier.

e Set the Files Of Type option to Part Document (*.par).
e Select the file named: Bucket2.par.

e Click Open.

Specify the drawing view layout

Drawing View Creation Wizard

Drawing View Layout

o

Primary View

dimetric
front
iso

Pic wiew
right
top

trimetric
user-defined

L)

ok | conel | [ nen |
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|
On the command bar, select the View Wizard — Drawing View Layout button. ==

You can use the Drawing View Layout page to specify the primary drawing view and
additional drawing views. The primary view is shown in the center.

You do not have to specify all the drawing views you want in this step, you can always
add them later using commands on the Home tab in the Drawing Views group.

e On the Drawing View Layout page, set the primary view to front.

e Select the top and right side views, as shown in the illustration below.

Drawing View Creation Wizard
Drawing View Layout
O 5
I 7
: I
l H/
Primary View
dimetric
front
is0
Pic wiew
right
top
trimetric
uger-defined
[ Ok ][ Cancel ] ’ Help l

e Click the Ok button to close the Drawing View Creation Wizard. Do not click the
drawing sheet yet.
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Place the views on the drawing sheet

S

e Take a few moments to observe the View Wizard command bar, which may be
displayed horizontally at the top of the application window or vertically along one
side, depending on the user interface theme you chose. Notice that the cursor display
has changed in the graphics window.

The command bar contains options for controlling the drawing view scale, view display
properties and so forth.

A ghosted image of the drawing views you defined in the wizard is attached to the cursor,
ready for you to position them on the drawing sheet. Do not click to place the views yet.

e Position the cursor approximately as shown above, then click to place the drawing
views.

|F————
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Observe the drawing views

S

Your drawing views should be displayed similar to the illustration.

Place another drawing view

You will now place another drawing view using the Principal View command. You can
use this command to fold out new drawing views from an existing drawing view.

(o]
e Choose Home tab—>Drawing Views group->Principal View. ]

e Position the cursor over the drawing view shown in the illustration below, then click
to select it.

Ok

e Move the cursor around the selected view and notice that a rectangular box is
attached to the cursor. Notice that the box size changes as you move into different
positions. The size change indicates a different view orientation.
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e Position the cursor as shown below, and then click to place an isometric drawing
view. Right - click to end command.

If you would like, place additional drawing views to observe the results.

|

Observe the results

|

Take a few moments to observe the new isometric drawing view.

T———=

You could have placed this drawing view with the other views using the Drawing View
Wizard.

If you placed extra drawing views, select the extra drawing views, and then press the
Delete key to delete them.
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Reposition a drawing view on the drawing sheet

You can adjust the position of a drawing view by dragging it to a new position.

R

e Press the <Esc> key to start the Select command.

e Position the cursor over the isometric drawing view.

When the view highlights, drag the cursor to reposition the drawing view to the top right
corner of the drawing sheet, as shown below.

e Hold the left mouse button while you drag the view.

e Release the mouse button to position the view.
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Reposition more drawing views

When you move an orthographic drawing view, such as a top, front, or right view, other
drawing views may move to maintain proper drawing view alignment. Drawing view
alignment lines are also displayed to indicate to which views it is aligned.

e Position the cursor over each of the three orthographic drawing views, then drag them
to new positions to observe how they remain orthographically aligned.

When you move an orthographic drawing view, orthographic alignment is maintained. If
you have placed dimensions and annotations on the drawing, these also move.

This makes it easy to adjust the position of the views on the sheet.

Save the file

AN

Your display should now approximately match the illustration.
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e Click the Application button to open the Application menu.
e On the Application menu, click Save As.

e Onthe Save As dialog box, in the File box, save the draft file to a new name or
location so that other users can complete this tutorial using the original file.

e Inthe Save As dialog box, click the Save button.

Observe the results

AN

Step 1 completed

(AN

You have finished placing principal views of the part on the drawing sheet.
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Step 2: Create a section view

- T Lo

e Ll

In the next few steps, you will create a section view.

To create section views, you first define a cutting plane on an existing drawing view using the
Cutting Plane command.

You then use the Section command to select the cutting plane and place the section view.

Select the drawing view for the cutting plane

e Choose Home tab->Drawing Views group—> Cutting Plane.

e On the drawing sheet, click the right drawing view shown below.

P——

b_ R

The command ribbon changes to display commands for drawing 2D elements. The Line
command is active.
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Use the Zoom Area command

e At the bottom-right side of the Solid Edge application window, click Zoom Area.

e Click above and to the left of the drawing view, and then click below and to the right
to zoom in around the drawing view.

i

e After you have resized the view area, click the right mouse button to exit the Zoom
Area command.

Draw the cutting plane
e Ensure that the Home tab—>Draw group—>Line command is running.

e Position the cursor over the center of the holes’ edge shown in the illustration below,
but do not click.

+o o
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e When the center relationship indicator displays, move the cursor to the up.

Notice that a dashed line is displayed between the center point you highlighted and the
cursor. This indicates that the start point of the line is aligned to the center point of the
hole.

e Click to place the start point of the line.

e Move the cursor to the down as shown below, and when the vertical relationship
indicator is displayed, click to place the end point of the line.

e Right-click to restart the Line command.

42 O
O O
<
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Close the cutting plane mode

Your cutting plane line should display similar to the illustration.

e Choose Home tab—>Close Cutting Plane. @

The cutting plane options are hidden.
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Specify the cutting plane direction

A = - A

A =—b—= A

e Move the cursor to the left side of cutting plane line, and notice that the view
direction arrows flip as the cursor crosses the cutting plane line.

e Position the cursor to the right side of the cutting plane line, then click to define the
cutting plane direction.
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Your cutting plane should display as shown below. Depending on the template used to
create your draft file, the cutting plane direction arrows might display with a different
symbology.

!—’-A
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Fit the view

1

e On the status bar at the bottom of the application window, choose Fit EI to fit the
drawing sheet to the application window.

Create a section view

e Choose Home tab->Drawing Views group->Section.

e Click the cutting plane line you created previously.
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e Position the cursor as shown below, then click to place the section view.

Observe the results

>N O O

Step 2 completed

1 <
N

e Click in empty space to clear the selection of the section view.
Your drawing sheet should be arranged similar to the illustration.
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Step 3: Create a detail view

D

In the next few steps, you will create a detail view.

You use detail views to show magnified areas on a drawing view. You can specify the scale you
want for the detail view. A detail view is dynamic, so if you modify the source view or move the
detail view circle on the source view, the detail view updates automatically.

Use the Zoom Area command

T T

e At the bottom-right side of the Solid Edge application window, choose Zoom Area.

[y
N
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e Zoom into the area shown in the illustration above.

e After you have resized the view area, right-click to exit the Zoom Area command.

Create a detail view
2

Take a moment to review the options on the Detail command bar. You can specify the
detail view scale, whether you want to use a circular detail view or draw a custom shape
for the detail view. For the detail view, you will use the default options.

e Choose Home tab->Drawing Views group-> Detail.

e Position the cursor over the section view, then click to define the center of the detail
view circle (1).

SECTION A-A

e Move the cursor to the side, and then click to specify the diameter of the detail view
envelope (2).

SECTION A-A
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e Move the cursor to position the detail view where you want it on the drawing, change
the scale on command bar to 5:1and then click (3).

‘o

SECTION A-A

Select the text label DETAIL B and move it closer to the view.

You can also draw a custom shape for the detail view area using options on the Detail
View command bar.
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Observe the results

Step 3 completed

You have finished creating the detail view.
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Step 4: Change drawing view properties

In the next few steps you will change the display properties for the isometric drawing
view.

Adjust the view area

e Use the Fit and Zoom Area commands to adjust the view area to display the isometric
view.
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Change the display properties for the isometric view

e Ensure that the Home tab—> Select group—> Select command is active.

e Select the isometric drawing view.

e Onthe Select command bar, click the Shading Options control and set the Shaded
| ﬁzﬁ] |

e Position the cursor in free space, and then left mouse click to end the command.

with Edges option.

e Notice that a grey box is displayed around the isometric view, and that the display has
not updated.
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Update the isometric drawing view

=

An Update View shortcut menu command is also available that allows you to update a
single drawing view. This command is useful when working with complex drawings
where updating all the drawing views at once could be time consuming.

e Choose Home tab—>Drawing Views group—>Update Views.

Observe the results
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Step 4 completed

You have finished changing the drawing view properties for the isometric view.

Deleting unwanted drawing views

e On the status bar at the bottom of the application window, choose Fit EI to fit the

drawing sheet to the application window.

e Ensure that the Home tab—> Select group—> Select command is active.

e Select the top drawing view.

A N

e Press the delete key on the keyboard, and then select yes on the confirmation dialog
box.
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e The unneeded drawing is deleted.

Create an auxiliary view

Choose Home tab->Drawing Views group—> Auxiliary. r?&

Take a moment to review the options on the Auxiliary command bar. You can specify the
style mapping, the drawing standard, a parallel or perpendicular fold, and display
settings. For the detail view, you will use the default options.

e Position the cursor over the edge shown and then click to select it.

e Move the cursor out towards the left and notice that a rectangular box is attached to
the cursor. Move the auxiliary view off the drawing sheet.
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Observe the results

-

Take a few moments to observe the new auxiliary drawing view.

Move the auxiliary view

Cut Ctrl=X
Copy Ctrl+C
Uncrop

Create Alignment

Delete Alignment

Maintain Alignment
Fit Drawing Yiew

Draw in View

When you create an auxiliary view, by default it is aligned with its source view. To move
the section view independently of its source view, you need to clear the Maintain
Alignment option first.

3

e Position the cursor over the auxiliary view, then right-click to display the shortcut
menu.

e Press the <Esc> key to start the Select command.
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e On the shortcut menu, click Maintain Alignment to clear the Maintain Alignment
option.

e Drag the cursor to move the section view to the location shown.

Notice that a dashed line connects the selected section view to its source view. This
indicator makes it easy to determine the source view for the section view later.

Observe the results

o o @
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Step 4 completed

e o @

m T

e Click in empty space to clear the selection of the auxiliary view.

Your drawing sheet should be arranged similar to the illustration.

Step 5: Add dimensions and annotations to the drawing

=5 o @

S i
=
=L

In the next few steps you will add dimensions and annotations to the drawing.
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You will use the Retrieve Dimensions command to retrieve model dimensions into the
drawing.

You will also use some of the other dimensioning and annotation commands to manually
add dimensions and annotations.
Adjust the view area

e Use the Fit and Zoom Area commands to adjust the view area to display the
drawing views shown below.

Retrieve dimensions from the model

The fastest way to add dimensions to a drawing is to retrieve the dimensions from the
model. You use the Retrieve Dimensions command to do this.

Fre
e Choose Home tab->Dimension group—> Retrieve Dimensions.
e On the Retrieve Dimensions command bar, set the Style option to ANSI (mm).

e Click the drawing view shown below.
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The retrieved dimensions are added to the drawing according to the current settings on
the Retrieve Dimensions command bar.

e Use the Select tool and move and delete dimensions until it matches the illustration
below.

e N
T
1

I
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Observe the results

Take a few moments to observe the retrieved dimensions.

Place dimensions using Smart Dimension

A robust set of dimensioning commands is available for adding dimensions to your
drawings.

e Use the Zoom Area command to zoom in around the side drawing view.

e Choose Home tab—>Dimension group—>Smart Dimension.

e Click the radius edge shown below on the front drawing view.
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e Click again to place the dimension.

T

e Use the Fit and Zoom Area commands to adjust the view area to display the
drawing views shown below.

e Left mouse click to end the Zoom command.

e Click the radius edge shown below on the right drawing view.
|
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e Click again to place the dimension, as shown below.

A
Cid
[

Add dimensions using the Distance Between command

In the next few steps, you will use the Distance Between command to add more
dimensions to the part.

- iy,

SECTION A—A\_

e Use the Fit and Zoom Area commands to zoom in on the section view.

e Choose Home tab->Dimension group-> Distance Between.
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You can use this command to dimension between multiple edges or sketch elements. You
can place chain or stacked dimensions with this command.

Defining and placing a dimension at the theoretical intersection of two
lines

e Position the cursor over the edge shown below, but don’t select it.

A
B

}

SECTION A—A\-__/'

e Position the cursor over the edge shown below, but don’t select it.

}

SECTION A—A\-__/'
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e Position the cursor at the approximate theoretical intersection of the two edges until
you get the intersection keypoint to display and then click to select it.

}

SECTION A—A\-__/'

e Position the cursor on the small vertical edge until the keypoint shown in the
illustration displays, and click to select it.
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e Move the cursor down and place the dimension.

e Position the cursor on the small vertical edge until the keypoint, and click to select it.

SECTION A—A\-__/'

3
i
]

168



e Move the cursor down until it aligns with the previous dimension, then move it to the
right and place the dimension as shown.

SECTION A—A\- '

|
oa
[

Add dimensions using the Distance Between command and the Use
Dimension Axis option.

In the next few steps, you will use the Distance Between command to add more
dimensions to the part at angle.
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e Use the Fit and Zoom Area commands to zoom in on the auxiliary view.

e Left mouse click to end the Zoom command or choose Home tab—> Dimension

™

group-> Distance Between.

e On the Distance Between tool bar, select the Use Dimension AXis

ey

el icon, and lastly, click the edge to

|Use Dimension Axis | | option, then select the

set the dimension axis.

e Position the cursor over the edge shown below, and then click to select it.
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Position the cursor over the hole’s edge, and then click to select it.
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e Position the cursor over the hole’s edge, and then click to select it.

e Position the cursor above the auxiliary view, then click to position the dimension.

e Right click to end the Distance Between command.

Observe the results

Take a few moments to observe the dimensions.
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Take a minute to utilize what you have learned and complete the
dimension in the order shown.

i
/ L
l
DETAIL B J ‘Q
- o
°
- -0 -
- -
P — S
Lig N 00 SECTION A-A 30 o R 30 A
o F 830 30

Place a center mark on a drawing view

VIEW C-C

You can add center line annotations to circular features, such as holes and cutouts, using
the Center Mark command.

e Use the Fit and Zoom Area commands to display the drawing view displayed
above.
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e Choose Home tab—> Annotation group—>Center Mark. On the Center Mark

command bar select the Use Dimension Axis |% | option, and then select the line
shown in the illustration below.

e On the Center Mark command bar, ensure that the Projection Lines option is
set.

e Select the 4 circular edges, to place the center marks.

VIEW C-C
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Fit the view and save the file

i ———
| — —

e On the status bar, choose Fit to fit the drawing sheet to the application window.

e Onthe Quick Access toolbar, choose Save.

Observe the results
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Step 5 completed

Although there are many more dimension and annotation options, you have learned the basics of
dimensioning and annotation.

If you would like to experiment with dimensions and annotations more, you can do so at the
conclusion of this activity.

Step 6: Edit the model and update the drawing

_

In the next few steps you will open the part model to make a design change. You will
then return to the drawing and update the drawing views.
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Open the part model

When working in a drawing derived from a 3D part or assembly, you can open the part or
assembly document directly from the drawing by double-clicking any drawing view.

e Ensure the Select command is active. \E

e Position the cursor over the isometric drawing view shown, then double-click to open
the part model.

The part model document is opened for editing.
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Select a feature to edit

[ |&] Base Reference Planes
[=I | ' Synchronous
= 4 Features
Protrusion 1
¢] Chamfer 5
7] Round 1
] Round 2
|+ Thin-Wall 1
= [FlHole1
[ Hole 1
33,» Pattern 1
7] Chamfer &
52 Used Sketches

e Position the cursor over the Protrusion 2 feature in PathFinder and when it highlights
click to select it.

Notice that the dimensions associated with the feature are automatically displayed, as
shown below.

e If necessary, zoom in on the dimensions to the view.
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Select the dimension to edit

e Position the cursor over the 130 dimension text, and click.

e Ensure that the red arrow is displayed at the right end of the dimension as shown.

e Type 160, and then press Enter to define the length of the feature.

e Position the cursor over the 30 dimension text as shown, and click.

18

(€=

e Ensure that the red arrow is displayed at the top end of the dimension as shown.
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e Type 20, and then press Enter to define the length of the feature.

Observe the results

Notice that the model changed in response to the dimension value edit.

Save and close the part document

e On the Quick Access toolbar, choose Save ‘E to save the edited part.

»
e Click the Application button Elg to display the application menu.

Close
e On the application menu, click Close to close the part document. @
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Observe the drawing views

1|

I

When you return to the drawing, the system prompts you that drawing views are out of
date. Click OK to dismiss this message.

Notice that a gray outline is displayed around each drawing view. The gray outline
around each drawing view means the views are out of date with respect to the part model.

Your change to the model caused the drawing views to go out of date.

Next, you will learn about the tools available for tracking drawing view and dimension
changes in a drawing.

Update the drawing views

e Choose Tools tab—-> Assistants group—> Drawing View Tracker.
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The Drawing View Tracker dialog box is displayed, listing all of the drawing views on
the drawing.

B " Drawing View Tracker ﬁ

Drawing view status:

[C: sers\t7npfm\Documents SoidEdge Modek FrontLoader Ordd
LT Prindpal (Sheet1)

LT Prindpal (Sheet1)

LT Pictorial (Sheet1)

[T SECTION A-A (Sheetl)
[T DETAILE (Sheet1)

LT wIEW C-C (Sheet1)

4 [ 1] [ 3

Update instructions:

[ Close ] [ Help ] [ Details == ]

L o

The icon to the left of each drawing view entry indicates that a view is out of date.

You can use the cursor to select an entry in the list, and the view highlights on the
drawing sheet.

e At the bottom of the Drawing View Tracker dialog box, click the Update Views
button to update all of the views at once.

Notice that the out-of-date icon in front of each drawing view name has been replaced by
a new symbol , which indicates that the drawing views are up to date.

e Onthe Drawing View Tracker dialog box, click Close.

The Dimension Tracker dialog box is automatically displayed. You will learn more about
this next.
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Observe the drawing views and Dimension Tracker

i

Notice that the gray boxes around the drawing views are no longer displayed. This
indicates the drawing views are up-to-date.

e Take a few moments to observe the Dimension Tracker dialog box. Notice that there
is an entry for the drawing dimension that corresponds to the model dimension you
edited.

e Ifrequired, move Dimension Tracker so that you can see all the drawing views.

e Click the dimension entry in Dimension Tracker and notice that the changed
dimension highlights, and that a revision triangle is displayed adjacent to the
dimension.

You can leave the revision triangle displayed, you can click Clear Selected to clear the

triangle for the selected dimension, or you can click Clear All to clear all of the revision
triangles.
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e On the Dimension Tracker dialog box, click Close.

N ™
Dimension Tracker
Report | Options
I Element Reason Previous Current Sheet
1 Dirmension (Linear) Value changed 130,00 mm 160.00 mm Sheetl
2 Dirmension (Linear) Value changed 30,00 mm 20.00 mm Sheetl
1 0 3

Close ] [ Help ]

2 dimension(s) found.

L

A

Dimension Tracker ensures you are aware of even the smallest design change during
drawing updates. You can choose to discard the revision marks after reviewing your

drawing or save them as revision notes. You can even specify the shape of the revision
balloon using the Options tab.

Save the drawing

| = T T

A ‘

e On the Quick Access toolbar, click the Save button to save the completed drawing.
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Congratulations!

You have completed the Test Drive.

To learn more about Solid Edge with Synchronous Modeling Technology, you can do the
following:

e Select Solid Edge Help from the Help menu, and explore topics that are related to the
subjects described in this Test Drive.

e Continue to experiment with the dimensioning and annotation options.

e Select View All Solid Edge Tutorials from the Start menu, and work through more of
the available tutorials.
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